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Descreen 4.0 Professional edition для Adobe Photoshop (Windows)








Назначение


Плагин–фильтр Descreen выполняет дескрининг — удаление полиграфического растра из сканированных печатных изображений (взятых из журналов, книг, альбомов, открыток и т.п.). Это предотвращает появление муара при дальнейшем использовании сканированных изображений.
Дескрининг состоит из двух операций:
• Удаление растра (пример на рис. 2).
• Подавление розеточного муара, присутствующего в цветных печатных изображениях (пример на рис. 3).



Использование фильтра (краткое введение)


Далее в описании предполагается, что пользователь знаком с основными функциями программы Photoshoр. Названия стандартных терминов программы Photoshop приводятся для ее англоязычной версии, поскольку в русскоязычном варианте они изменяются от версии к версии. Возможные русскоязычные аналоги приведены в таблице.
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Рис. 1а. Сокращенное диалоговое окно фильтра (при крупном системном шрифте). Назначение неподписанных кнопок показывается во время работы фильтра в виде подсказок при подведении к ним указателя мыши.

[image: ]

 
Рис. 1б. Расширенное диалоговое окно фильтра (при крупном системном шрифте). Назначение неподписанных кнопок показывается во время работы фильтра в виде подсказок при подведении к ним указателя мыши. Переключение между расширенным и сокращенным окнами осуществляется кнопкой, расположенной в правом нижнем углу диалогового окна.
В этом разделе на четырех примерах показывается как пользоваться фильтром. Предполагается, что это поможет быстро начать работать с данным плагином. Для тех, кому часто приходится иметь дело с обработкой печатных оригиналов и кто желает как можно полнее овладеть всеми тонкостями предназначены последующие разделы настоящего руководства.

Пример 1. Удаление растра из черно–белого изображения в автоматическом режиме.


Откройте в программе Photoshop изображение gray1.jpg, входящее в дистрибутив (папка Images). Вызовите фильтр Descreen из меню Filter > Blur. Установите флажок Automatic. Нажмите OK. Это простейший способ использования фильтра Descreen. В нем не требуется введения каких–либо настроек — они определяются автоматически после нажатия кнопки OK. Таким путем можно обрабатывать и цветные изображения. Этот способ, однако, не всегда дает наилучший результат из всех возможных.
Закройте изображение gray1.jpg без сохранения, оно еще понадобится в исходном виде.

Пример 2. Удаление растра из черно–белого изображения.


Откройте изображение gray1.jpg. Вызовите фильтр Descreen. Снимите флажок Automatic, если он стоит. На ползунке Screen автоматически выставится измеренная частота растра (если этого не произошло, или на кнопке рядом с ползунком изображена рука, нажмите эту кнопку для измерения частоты). Нажмите кнопку ОК. Изображение будет отфильтровано. Закройте изображение без сохранения.

Пример 3. Удаление растра и розеточного муара из цветного изображения.


Откройте в программе Photoshop изображение sample1.jpg, входящее в дистрибутив. Вызовите фильтр Descreen. Установите флажок Reduce Moire. В диалоговом окне отобразятся частота растра и углы красок CMK. Нажмите кнопку OK. Закройте изображение без сохранения.
Если посмотреть канал Blue в отфильтрованном изображении, то можно увидеть неравномерные пятна. Это так называемый печатный или розеточный муар. В каналах Red и Green наиболее заметен розеточный муар, который образуется из–за наложения в полиграфическом оттиске красок CMK друг на друга. В канале Blue наиболее заметен муар, образующийся из–за наложения желтой краски Y на краски CMK. Поскольку были заданы величины углов наклона растра красок CMK (они автоматически измеряются плагином) и не был задан угол Y (его плагин автоматически не определяет и ячейка желтой краски осталась пустой), то в каналах Red и Green растр был удален, а в канале Blue — нет. Более того, в данном изображении фильтр не сможет ослабить розеточный муар в канале Blue, даже если задать угол наклона растра желтой краски. Дело в том, что для подавления розеточного муара необходимо чтобы в изображении были точно воспроизведены мелкие детали, а в данном случае изображение было сжато в формате JPEG, который, как известно, вносит искажения. Для удаления муара из каналов Red и Green качества хватает, а для канала Blue — нет. Чтобы удалять розеточный муар из канала Blue необходимо более точное воспроизведение изображений, в частности, вместо формата JPEG следует использовать формат TIFF. К счастью, у канала Blue есть хорошее свойство: дефекты в нем слабо сказываются на восприятии изображения в целом и во многих случаях их можно оставить (по этой причине при сжатии изображений информацию в этом канале больше ужимают, чем в других). Если изображение планируется использовать не для показа на компьютере, а для офсетной печати, то желательно все же очистить канал Blue от дефектов, в частности, от розеточного муара, поскольку при цветоделении (т.е. при конвертации в CMYK) они частично окажутся в других каналах.

Пример 4. Удаление растра и розеточного муара из сканированного цветного изображения.


Сканируйте в режиме RGB небольшое (примерно 5 х 5 см) цветное печатное изображение с разрешением 600…800 ppi. Если сканер имеет функции Descreen (подавление растра), Sharpen (повышение резкости) или систему управления цветом, они должны быть отключены (как правильно настроить систему управления цветом для совместной работы с фильтром Descreen, объясняется в разделе Сканирование оригиналов). Сканировать следует в масштабе 1:1, выходное разрешение изображения должно быть равно разрешению сканирования (проверить выходное разрешение изображения можно в программе Photoshop через меню Image > Image size). Если вы сканируете не прямо из программы Photoshop, то сохраняйте изображение в формате TIFF (сохранение в формате JPEG приводит к искажению цветов в изображении; если все же используется JPEG, то выберите наивысшее качество в его установках). Вызовите фильтр Descreen. Установите флажок Reduce Moire. Если изображение правильно отсканировано и содержит отчетливый растр, в диалоговом окне отобразятся частота растра и углы красок CMK. Если этого не произошло, попробуйте изменить область предварительного просмотра и воспользоваться кнопками измерения частоты и углов растра (при подведении указателя мышки к неподписанным кнопкам показываются подсказки с их названиями). Сначала измеряется частота, а затем — углы. Когда частота растра и его углы будут измерены, можно нажать кнопку OK, до этого она будет заблокирована.
Если вам удалось успешно удалить растр и розеточный муар, попробуйте удалить розеточный муар не только из каналов Red и Green, но и из канала Blue. Откройте исходное изображение. Для удаления розеточного муара из канала Blue должны быть заданы углы наклона растров не только красок CMK, но и краски Y. Для этого включите просмотр канала Blue (нажав кнопку B) и нажимая маленькие стрелочки рядом с ячейкой Y, выберите такое значение угла, при котором наблюдаемый муар будет минимальным. Затем, просматривая канал Blue, подберите такое значение регулировки Sensitivity Blue, при котором муар в этом канале будет наименьшим. Когда все углы заданы, нажмите OK.
Если вам вовсе не удается отфильтровать изображение, попробуйте обработать его в режиме Automatic (см. Пример 1) или взять изображение из другого печатного издания. Если фильтр по–прежнему не работает, то наиболее вероятная причина этого — неправильное сканирование (как правильно сканировать печатные оригиналы описано в разделе Сканирование оригиналов). Другие типичные затруднения описаны в разделе Разрешение проблем.
Пример правильно сканированного изображения для упражнений можно загрузить на сайте плагина.
Далее можно либо продолжить освоение плагина эмпирическим путем, либо углубиться в другие разделы руководства. Предполагается, что пользователь знаком с понятиями растра, цветной растровой печати и розеточного муара (см. Словарь терминов). Если вам необходимо получить наилучший результат при подготовке изображения к офсетной печати — см. Подготовка изображений для офсетной печати.



Использование фильтра (подробное описание)


Удаление полиграфического растра состоит из двух операций: 1) удаления растра; 2) подавления розеточного муара (только в цветных изображениях). Для удаления полиграфического растра необходимо правильно сканировать изображение, как описано в разделе Сканирование оригиналов.

1) Удаление растра


Для удаления растра нужно точно указать частоту растра (линиатуру) регулировкой Screen (см. рис. 1). Пример удаления растра показан на рис. 2. Обычно плагин сам измеряет линиатуру, но в редких случаях это ему не удается и тогда приходится указывать ее вручную. Например, это может случиться, если в изображении мало участков с отчетливым растром. Задание частоты растра выше фактической приводит к неполному удалению растра, а ниже фактической — к излишней потере резкости. 

[image: ]


[image: ]

 
Рис. 2. Удаление растра из черно–белого изображения (щелкните, чтобы увеличить).
Слева — исходное изображение, справа — после удаления растра.
Традиционный метод борьбы с растром — размывание изображения — работает схожим образом. Различие состоит в том, что традиционный метод лишь уменьшает, но полностью не удаляет растр. Из–за этого бывает трудно выбрать конкретную величину размывания — либо получается излишняя потеря резкости изображения, либо остаются следы растра. Фильтр Descreen позволяет получить оптимальный результат: полное удаление растра при минимальной потере резкости.
Регулировки удаления растра подробно описаны в разделе Регулировки плагина.

2) Подавление розеточного муара


При удалении полиграфического растра из цветных изображений (книг, журналов, альбомов и т.д.) возникает необходимость в дополнительной операции — подавлении присутствующего в них розеточного муара (пример см. на рис. 3).
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Рис. 3. Удаление растра и подавление розеточного муара (щелкните, чтобы увеличить).
1) Исходное изображение.
2) Оно же после удаления растра. Отчетливо заметен розеточный муар.
3) Оно же после удаления растра с подавлением розеточного муара. 
Для подавления розеточного муара нужно установить флажок Reduce Moire и указать величины углов наклона растра голубой (C), пурпурной (M), черной (K) и желтой (Y) красок в отсканированном изображении (см. рис. 1). По этим углам и по частоте растра плагин рассчитывает параметры розеточного муара и подавляет его. При неправильном задании углов или частоты растра подавления муара не получится, а может даже наоборот, возникнуть дополнительный муар. Обычно, если изображение правильно отсканировано, плагин сам измеряет углы наклона растра красок CMK. Когда же ему это не удается, их приходится вводить вручную. Угол желтой краски (Y) подбирается вручную по минимуму розеточного муара в канале Blue. Для этого нужно включить просмотр канала Blue (нажав кнопку B) и нажимая маленькие стрелочки рядом с ячейкой Y, выбрать такое значение угла, при котором муар будет минимальным. Если угол желтой краски не задан (ячейка оставлена пустой), то удаление розеточного муара выполняется только в каналах Red и Green.
Подавление муара осуществляется фильтром только в цветовом режиме RGB. Обычно это не вызывает затруднений, поскольку сканирование всегда выполняется именно в этом режиме (при сканировании в режимах CMYK или Lab в действительности происходит сканирование в режиме RGB с одновременной конвертацией в CMYK или Lab).
Регулировки подавления розеточного муара подробно описаны в разделе Регулировки плагина.
Углубленные сведения о полиграфическом растре и об алгоритме его удаления можно найти в Словаре.



Регулировки плагина


Далее описываются все регулировки плагина. В диалоговом окне плагина они разбиты на две группы соответственно двум операциям упомянутым выше (см. рис. 1). Когда задано недостаточно параметров для фильтрации кнопка OK будет заблокирована. Можно получить подсказку о недостающих параметрах, нажав кнопку с зеленой буквой "i"

«Screen (Растр)»


Эта регулировка должна быть равна частоте растра обрабатываемого изображения. Пока частота растра не задана (равна нулю в диалоге), кнопка OK будет заблокирована, поскольку без задания частоты удаление растра невозможно.
При вызове плагин сам измеряет частоту растра в той области изображения, которая показывается в окне предварительного просмотра. В случае успешного измерения частота выставляется на ползунке Screen и показывается слева от него. При неудаче частота устанавливается в ноль.
Если частота растра не определилась при открытии диалога, следует изменить область просмотра и затем повторить измерение, нажав кнопку измерения частоты, расположенную справа от ползунка Screen (см. рис. 1). Измерение желательно производить в области с отчетливым растром. Если плагину не удается измерить частоту растра ни в каких областях изображения — см. Разрешение проблем.
При возникновении необходимости задания частоты растра вручную (с помощью ползунка) ее можно подбирать, ориентируясь на то, что она должна быть равна максимальной из тех, при которых растр подавляется полностью. Необходимо отличать растр от розеточного муара — на этапе подбора частоты должен подавляться только растр. Хотя задание достаточно низкой частоты позволяет подавить и розеточный муар, это приведет к излишней потере резкости (после задания правильной частоты растра розеточный муар подавляется без потери резкости путем установки флажка Reduce Moire). Подбор правильной частоты требует некоторого опыта, поэтому лучше не подбирать ее, а сразу ввести точное значение. Для этого частоту следует предварительно измерить в программе Photoshop (см. описание процедуры измерения).
При задании частоты с помощью ползунка, на кнопке измерения частоты появляется изображение руки. Это служит напоминанием, что частота не измерена плагином, а задана пользователем вручную.

«Expected Screen Range (ожидаемый диапазон линиатур)»


Задает диапазон для автоматического поиска частоты растра. Изменение диапазона требуется только в том случае, если плагин неправильно измеряет частоту. Для повышения надежности измерения диапазон следует сузить.
При измерении плагином частоты растра поиск частоты производится не во всем диапазоне возможных линиатур от 0 до бесконечности, а в ограниченном диапазоне. Заложенный в плагин алгоритм позволяет измерять (и удалять) растр в диапазоне от D/8 до D/3 lpi, где D — разрешение обрабатываемого изображения в ppi.
Например при D = 600 ppi, допустимый диапазон будет равен 75…200 lpi.
На практике такая ширина диапазона может быть избыточной и ее лучше дополнительно ограничить, чтобы повысить достоверность измерения частоты растра и следовательно надежность работы фильтра. Это может быть особенно актуально при пакетной обработке сотен файлов из одного издания, в котором линиатура одинакова. Например, если она равна 150 lpi, то будет разумно ограничить диапазон поиска до 140…160 lpi. См. типичные значения линиатуры.
Ожидаемый диапазон линиатур может быть установлен в пределах 75…299 lpi и может выходить за границы допустимого диапазона D/8…D/3 lpi. Однако, поиск частоты растра всегда производится только на пересечении установленного ожидаемого диапазона с диапазоном D/8…D/3 lpi.
Если эти диапазоны не пересекаются вовсе, или частота растра не попадает в их пересечение, то правильная фильтрация будет невозможна. Такая ситуация может иметь место либо при слишком низком разрешении изображения, либо при слишком высоком. Например, если изображение было сканировано с разрешением 300 ppi, то допустимый диапазон будет 38…100 lpi. Если при этом частота растра равна 150 lpi, то правильная фильтрация будет невозможна. Такое изображение нужно сканировать заново, с разрешением 600 ppi. При слишком высоком разрешении достаточно будет понизить его до оптимального (равного линиатуре, умноженной на 3.5…5.0).
Если диапазон не был задан вручную, то при открытии диалогового окна фильтра он автоматически устанавливается в максимально возможный для текущего изображения. Восстановить диапазон после ручного его изменения можно с помощью кнопки восстановления диапазона, расположенной справа от ячеек диапазона (см. рис. 1).
Поскольку плагин может обрабатывать лишь изображения, частота растра (линиатура) которых от 75 до 299 lpi (линий на дюйм), то для обработки изображений с растром менее 75 lpi или более 299 lpi их следует масштабировать так, чтобы частота растра попала в диапазон 75…299 lpi. Например, если изображение имеет линиатуру 50 lpi (некоторые старые газеты), его можно сканировать с разрешением 200 ppi, a затем изменить разрешение без ресамплинга на 600 ppi; тогда линиатура станет равной 150 lpi.

«Sharpness (Резкость)»


Данная регулировка используется для компенсации потери резкости изображения при сканировании. Иногда бывает полезным и уменьшение резкости. Например, оно используется для уменьшения эффекта рваных краев и для уменьшения артефактов при удалении растра из изображений с очень резким краем растровой точки.

«Reduce Moire (Подавить муар)»


Установка этого флажка активирует модуль подавления розеточного муара (см. рис. 1). Этот модуль позволяет удалить или по крайней мере ослабить розеточный муар. Флажок доступен только в режиме RGB. Подавление муара должно производиться одновременно с удалением растра. Модуль подавления муара не будет правильно работать, если в изображении отсутствует растр (например, если он был ранее удален).

«Screen Angles (Углы растра)»


Для удаления розеточного муара помимо частоты растра необходимо задать углы наклона растра. При установке флажка Reduce Moire плагин автоматически измеряет углы CMK в области предварительного просмотра (если правильно задана частота растра). В случае успешного измерения углы вносятся в соответствующие ячейки. При неудаче попытку можно повторить в другой области просмотра, воспользовавшись кнопкой измерения углов (см. рис. 1). Если углы не удается измерить таким путем, их нужно ввести вручную, предварительно измерив в программе Photoshop (см. описание процедуры измерения). Если задано меньше двух углов, кнопка OK будет заблокирована, поскольку без задания углов подавление муара невозможно.
Цвет букв CMKY над ячейками с величинами углов (см. рис. 1) показывает как было получено соответствующее значение угла. Черный — значение угла было измерено плагином. Серый — значение было введено вручную или было предложено плагином на основании измеренных углов. Обычно угол между красками CMK составляет 30 градусов, поэтому когда известен хотя бы один угол, можно сделать предположение о величине других.
Если изображение напечатано двумя красками, то углы следует проставить только в двух соответствующих ячейках, а третью очистить. Двухкрасочные изображения не следует обрабатывать в режиме Automatic или через Ctrl+F — это может привести к усилению муара, поскольку в этих режимах плагин будет обрабатывать их как полноцветные.
Начиная с версии 3.5 порядок углов CMK значения не имеет: если переставить местами величины любых двух углов, результат будет тем же. Поэтому если плагин путает их при измерении, на это можно не обращать внимания. Однако, углы CMK не должны переставляться местами с углом Y.
Розеточный муар удаляется в канале Blue, только когда задан угол Y. Угол Y автоматически не измеряется плагином, поскольку желтая краска чаще всего скрыта под другими красками и ее трудно идентифицировать. Когда установлены углы CMK, нужно вручную подобрать такое значение Y, при котором муар в канале Blue будет минимальным. Как правило, угол Y расположен между какими–то двумя углами из CMK. В качестве первого пробного значения можно взять среднее значение двух близкорасположенных углов из CMK. Если оно не подошло, то остается еще два возможных значения, отличающихся от него на 30 и 60 градусов. Например, при C68 M8 K38, в качестве первого значения Y можно взять 23. Если оно не подошло, попробовать 53 и 83. Маленькие стрелки рядом с ячейкой желтого угла предназначены для автоматического вычисления желтого угла таким способом.

«Sensitivity (Уровень)»


Задает чувствительность алгоритма подавления розеточного муара.
В расширенном диалоговом окне эта регулировка разбита на три отдельные регулировки: Sensitivity Light, Sensitivity Dark, Sensitivity Blue (см. рис. 1).
Для подбора этой регулировки поставьте ползунок в крайнее левое положение, что соответствует наименьшей чувствительности. В результате этого розеточный муар не будет подавляться. Далее увеличивайте чувствительность, сдвигая ползунок вправо, пока розеточный муар не начнет подавляться (в окне предварительного просмотра). Начиная с некоторого положения ползунка улучшения в подавлении муара больше не будет. Обычно это и есть оптимальное значение. Выбор большей чувствительности результат не улучшит, но повысит вероятность появления ложного муара. При появлении ложного муара следует уменьшить чувствительность до его исчезновения.

«Sensitivity Light (Уровень светлого)»


Задает чувствительность алгоритма подавления розеточного муара в светлых областях изображения в каналах Red и Green.

«Sensitivity Dark (Уровень темного)»


То же, что Sensitivity Light, но в темных областях.

«Sensitivity Blue (Уровень синего)»


Задает чувствительность алгоритма подавления розеточного муара в канале Blue. Для подбора этой регулировки следует включить просмотр канала Blue (нажать кнопку "B"). Муар в канале Blue подавляется только тогда, когда задана величина угла растра желтой краски (ячейка "Y").

«Variant (вариант)»


Эта регулировка используется редко. Эта регулировка переключает алгоритм фильтрации на альтернативные варианты, чтобы уменьшить ложный муар или по крайней мере сместить его в другое место. Если области ложного муара окажутся в других местах, то следует просто скомбинировать два варианта, используя технику маскирования. Данная версия фильтра не позволяет правильно показать результат этой регулировки в окне предварительного просмотра, поэтому ее приходится подбирать, выполняя фильтрацию изображения (или его выделенной части). 

«Tune (тонкая подстройка)»


Эта регулировка используется редко. Подбирается такой, чтобы розеточный муар подавлялся более полно. При установленном флажке AutoTune оптимальное значение этой регулировки определяется автоматически, раздельно для каждого канала RGB, после нажатия кнопки OK. Ручной подбор может потребоваться, если в изображении малы участки, в которых есть розеточный муар (менее 5% по площади). На таких изображениях автоматическое определение этой регулировки может оказаться не лучшим из возможных. Чтобы подобрать ее вручную, нужно снять флажок AutoTune и подобрать значение, при котором муар будет минимальным. При ручной регулировке задается одинаковое значение для всех трех каналов. Для автоматического поиска оптимального значения можно воспользоваться кнопкой справа от ползунка. При установленном флажке AutoTune фильтрация в окне предварительного просмотра осуществляется с Tune = 10 для всех каналов.

Ложный муар


При подавлении розеточного муара с помощью плагина Descreen иногда происходит усиление муара или появление его там, где раньше его не было. Этот феномен обозначается в данном описании как ложный муар. Ложный муар, как правило, возникает рядом с теми областями изображения, которые содержат проблемные (с точки зрения удаления розеточного муара) элементы: скопления мелких деталей и резкие линии, параллельные линиям растра. Примером проблемной области может служить футболка с буквами на рис. 2. В большинстве случаев появление ложного муара удается устранить с помощью регулировки Sensitivity (в расширенном диалоговом окне эта регулировка разделена на три регулировки — Sensitivity Light, Sensitivity Dark, Sensitivity Blue) и Variant. Если это не помогает следует использовать Технику маскирования. В тяжелых случаях применяется Техника маскирования 3.



Сканирование оригиналов



Сканирование обычных растровых оригиналов


Работа фильтра Descreen основана на анализе мелких деталей офсетного растра в печатном оригинале. Поэтому для удаления растра и, особенно, для удаления розеточного муара, важно, чтобы при сканировании эти детали были правильно воспроизведены. Правильно сканированное изображение фильтр должен обрабатывать без затруднений.
Прежде всего, необходимо, чтобы разрешение сканирования было достаточно высоким, а именно не менее 3*S ppi, где S — линиатура оригинала в lpi (интересующиеся могут найти объяснения этого требования в конце этого раздела). Оптимальное для работы фильтра разрешение изображения: 3.5*S…5*S ppi. Разрешение изображения не должно превышать 8*S ppi, иначе фильтр не сможет его обработать. Если разрешение изображения превышает 8*S ppi, его нужно понизить в программе Photoshop, используя команду Image Size с бикубической интерполяцией. Если разрешение изображения меньше 3*S ppi, его необходимо сканировать заново с правильным разрешением.
Таким образом, чтобы выбрать разрешение сканирования нужно приблизительно знать S — линиатуру оригинала. Для этого можно использовать специальные измерительные линейки (их можно получить в бюро допечатной подготовки, как правило, бесплатно) или сканировать с оптическим разрешением сканера небольшой (5х5 мм будет достаточно) фрагмент изображения с отчетливым растром и измерить его линиатуру в программе Photoshop (см. описание процедуры измерения). После небольшой практики нетрудно научиться приблизительно определять линиатуру "на глаз". Точности в 20% вполне достаточно для выбора разрешения сканирования. Фактически, можно поступать еще проще: если линиатура не очень велика (до 180 lpi, а это 95% всех случаев) - сканировать с разрешением 600 ppi, если же она выше 150 lpi — сканировать с 1200 ppi (см. также следующий абзац). Если окажется, что разрешение сканирования завышено (превышает 8*S ppi), то его можно понизить в программе Photoshop до оптимального 4*S ppi, используя команду Image Size с бикубической интерполяцией.
Разрешение сканирования необходимо выбрать так, чтобы оно было делителем оптического разрешения сканера (в противном случае качество сканирования будет снижено). Например, при оптическом разрешении 5200, нужно сканировать с разрешением 400, 520, 650, 1040, 1300, 2600 или 5200; а при при оптическом разрешении 1200, нужно сканировать с разрешением 400, 600 или 1200. Рекомендацию предыдущего абзаца необходимо скорректировать с учетом этого.
Чтобы не просвечивали изображение и текст на обратной стороне сканируемого оригинала, следует приложить к обратной стороне лист черной бумаги.
Если сканер позволяет задавать диапазон плотностей при сканировании, то его нужно установить таким, чтобы бумага была почти белой, а участки изображения с черной краской — почти черными. Убедитесь, что во всех каналах изображения нет клиппинга. В участках с клиппингом не удастся ослабить муар.
Угол, под которым оригинал лежит на сканере, значения не имеет. Исключение составляет случай, если вы измеряли углы растра в оригинале с помощью специальной линейки и хотите ввести их значения в плагин — тогда при сканировании оригинал нужно положить вертикально (или горизонтально) с погрешностью не более одного градуса.
Системы управления цветом могут вносить изменения в поступающую со сканера цветовую информацию, что мешает восстановлению параметров растра. Иногда это вызывает неправильное подавление розеточного муара. Чтобы этого не происходило, настройте систему управления цветом таким образом, чтобы к файлу изображения присоединялся цветовой профиль сканера, но само изображение оставалось неизмененным. Если используемая система управления цветом не позволяет ее настраивать, то попробуете ее отключить, а коррекцию цвета выполнять после применения фильтра Descreen.
Следующие требования являются обязательными:
• Сканировать следует без масштабирования (масштаб 1:1). В противном случае качество сканирования растрового оригинала может существенно снизиться. Фильтр использует значение разрешения изображения, которое отображает программа Photoshop в меню Image > Image size. Для правильной работы оно должно быть равно разрешению сканирования. Если это не так, нужно настроить сканер, чтобы его входное разрешение было равно выходному (см. документацию на программное обеспечение сканера). В противном случае вам придется менять разрешение изображения в программе Photoshop (для этого выберите меню Image > Image size и введите разрешение изображения, равное разрешению сканирования; обратите внимание: флажок Resample Image должен быть снят).
• Если за один проход сканировалось несколько оригиналов, то перед обработкой их необходимо разрезать на отдельные части, поскольку они могут иметь разные параметры растра, в частности они могут лежать на стекле под разными углами.
• Если изображение после сканирования записывается в файл и впоследствии из него предполагается удалять растр, тогда не используйте формат JPEG и другие форматы, приводящие к потере информации. Используйте формат TIFF или другой, не приводящий к потерям. Если это невозможно, то используйте минимальное сжатие, чтобы потери были минимальны.
• Если используемый сканер имеет функции Descreen (снятие растра) или Sharpen (повышение резкости), они должны быть отключены при сканировании. В противном случае обработка плагином Descreen может оказаться невозможной.
• При сканировании цветных растровых изображений не следует использовать компенсационные кривые, поскольку это вносит изменения в параметры растра и мешает работе фильтра. Однако можно и даже желательно использовать коррекцию гаммы.

Сканирование высококачественных растровых оригиналов


К таким оригиналам относятся те, у которых очень резкие края растровых точек. Это могут быть фотонаборные пленки и печатная продукция, изготовленная на новом печатном оборудовании на хорошей мелованной бумаге. Сканирование высококачественных оригиналов имеет свои особенности, связанные с тем, что при резких краях растровых точек в частотном спектре изображения велика амплитуда высокочастотных гармоник растра (2*S, 3*S и т. д). Эти гармоники, как и основной пик растра, могут создавать муар при сканировании, а также при ресамплинге (более подробно об этом см. Оцифровка сигналов).
Чтобы избежать образования муара при сканировании сканируйте оригинал с оптическим разрешением сканера. Если сканер имеет высокое оптическое разрешение и возможность оптического расфокусирования, то разрешения порядка 1200 ppi в сочетании с небольшим расфокусированием будет достаточно. Расфокусирование должно лишь слегка размыть края растровых точек (размытие от 1/10 до 1/5 от расстояния между центрами растровых точек). Поскольку изображения при большом разрешении могут занимать много места (А3 в режиме Grayscale при 3600 ppi занимает 2.5 Gb), возможность использовать благодаря расфокусированию меньшее разрешение весьма полезна.
При большом разрешении сканирования разрешение изображения может оказаться выше 8*S ppi, где S — линиатура растра в lpi. Для обработки такого изображения фильтром Descreen, необходимо понизить разрешение, чтобы оно попало в интервал 3*S…8*S (а по возможности — в 3.5*S…5*S). Для понижения разрешения изображений с четкими краями растровых точек следует использовать специальный плагин Downsample, а не штатную команду Image Size.
Вопрос о том, к какому типу оригиналов относится конкретное издание можно решить опытным путем. Выберите из этого издания какое–нибудь изображение с ровными участками (муар обычно наиболее заметен на ровных участках) и сканируйте его один раз как обычное, а другой раз как высококачественное. Выберите лучший результат. Если у вас есть микроскоп, то после небольшой практики вы сможете визуально определять резкость краев растровой точки и соответственно этому выбирать разрешение сканирования.
Различия между обычными оригиналами и высококачественными актуальны только для сканеров с большим оптическим разрешением, — если оптическое разрешение сканера невысоко, то почти все оригиналы приходится сканировать с оптическим разрешением независимо от того, к какому типу они относятся.

О факторах, влияющих на качество результата


Низкое качество результата фильтрации в большинстве случаев связано с низким качеством сканера, неправильным его использованием, низким качеством оригинала или неправильной настройкой фильтра. Как настраивать фильтр и сканировать оригиналы обсуждалось выше, поэтому здесь рассматриваются только два оставшихся фактора — низкое качество сканера или оригинала.
Для работы фильтра Descreen важно, чтобы сканер имел достаточно высокую разрешающую способность. В некачественных сканерах разрешающая способность может быть существенно ниже заявленного оптического разрешения. Если разрешающая способность сканера ниже 3*S lpi, где S — частота растра изображения в lpi, фильтру редко будет удаваться определить частоту растра такого изображения и еще реже — углы наклона растра. Их придется вводить вручную. С таким изображением фильтр не сможет работать в режиме Automatic. Кроме этого, полученный результат будет уступать тому, который мог бы быть получен при использовании качественного сканера. Это будет особенно заметно на цветных изображениях при подавлении розеточного муара: муар будет слабо подавляться, а в канале Blue его может вовсе не удастся ослабить (в этом случае лучше оставить ячейку желтого угла пустой, чтобы фильтр не пытался подавлять муар в канале Blue).
Качество фильтрации также ухудшается, если при сканировании в изображении появляются склейки или щели. Многие сканеры считывают изображения кусочками (такие сканеры время от времени останавливаются для обработки очередной порции). Если механика сканера недостаточно точна, кусочки склеиваются неточно и возникают дефекты, видимые в Photoshop при увеличении в 100%. Поскольку размер кусочков определяется внутренним буфером сканера и пропускной способностью интерфейса, то чем меньше сканируемое изображение, тем меньше будет искажений. Исходя из этого, желательно не сканировать сразу несколько изображений на одном листе, лучше сканировать их по отдельности. Изображения лучше располагать короткой стороной параллельно сканирующей линейке — в этом случае поток информации будет меньше. Для качественных сканеров эти рекомендации неактуальны.
Если есть сомнения относительно качества вашего сканера, их можно разрешить путем сравнения с заведомо качественным сканером. Сканируйте в бюро допечатной подготовки качественное печатное изображение с разрешением 1200–1400 ppi (лучше взять с запасом: при необходимости разрешение всегда можно потом уменьшить). Желательно, чтобы изображение содержало как ровные участки, так и четкие мелкие детали — это поможет оценить качество. Проследите, чтобы при сканировании были выполнены требования к сканированию. Обработайте сканированное изображение фильтром Descreen и сравните с тем, что получается на вашем сканере.
К оригиналам низкого качества относятся прежде всего напечатанные на немелованной бумаге, например, газеты. После фильтрации таких изображений становятся заметными сильная зернистость, пятнистость и завалы в тенях. Зернистость и пятнистость появляются из–за неоднородностей бумаги, а завалы — из–за растекания краски по бумаге. Оценить качество печати можно с помощью микроскопа: если растровые точки имеют ровные края, качество высокое. Чем более рваные края у растровых точек, тем ниже качество печати и тем больше будет зернистость в отфильтрованном изображении.
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Рис. 6. Формирование растровой точки (увеличено в 100 раз).
Слева направо:
1) в растрированном файле;
2) на фотонаборной пленке, засвеченной с этого файла;
3) печать на хорошей мелованной бумаге с этой пленки;
4) печать на немелованной бумаге с той же пленки.
Обращают на себя внимание деформация края растровой точки, неоднородность заливки и растискивание (растекание краски), особенно значительное на немелованной бумаге. Из–за плохого впитывания краски на немелованной бумаге не удается получить насыщенных цветов. Кроме того, немелованная бумага имеет более низкую белизну, чем мелованная. Из–за двух последних факторов изображения на немелованной бумаге получаются менее яркими и менее контрастными, чем на мелованной.
При использовании печатных оригиналов очень высокого качества (т. е. с очень четкими краями растровых точек) во время их сканирования или обработки может возникать муар. Чтобы избежать этого, следует предпринимать определенные меры предосторожности — см. Сканирование высококачественных растровых оригиналов.

Почему разрешение сканирования печатных оригиналов должно быть не менее 3*S?


Это необходимо для того, чтобы при сканировании избежать появления муара и правильно воспроизвести основные спектральные пики растра, что в свою очередь необходимо для качественного удаления растра. Максимальная частота основных пиков растра равна 1,41*S, где S — линиатура растра, и для правильного их воспроизведения необходимо, чтобы разрешение сканирования минимум в два раза превышало их частоту (более подробно об этом см. Словарь: Оцифровка сигналов и Удаление растра). Отсюда получается, что разрешение сканирования должно быть не менее 2*1,41*S ppi, что приблизительно равно 3*S ppi, где S — линиатура растра в lpi. Если разрешение сканирования будет меньше, то на этапе сканирования может появиться муар из–за интерференции растра печатного изображения с растровой линейкой сканера. Теоретически, для достижения максимального качества сканирования желательно, чтобы разрешение сканирования было как можно больше. Это связано с тем, что наряду с основными пиками растра обычно присутствуют многочисленные пики его гармоник на более высоких частотах и они тоже могут давать муар при сканировании. Однако, на практике растровые точки никогда не имеют идеальных краев и кроме этого в изображениях всегда присутствует шум, который скрывает мелкие детали — амплитуда высокочастотных гармоник, начиная с некоторой частоты становится меньше амплитуды шума. Поэтому на практике не бывает необходимости сканировать печатные оригиналы с разрешением более 16*S, а для большинства оригиналов достаточно 4*S.



Средства автоматизации


Использование возможностей автоматизации Photoshop (меню File > Automate > Batch) иногда позволяет сэкономить много времени при однотипной обработке большого числа файлов. Используйте log–файл для сообщения об ошибках, чтобы процесс не прерывался диалогами. При фильтрации большого числа файлов (сотен или более) следует сузить интервал поиска частоты растра, чтобы повысить надежность работы фильтра (см. Expected Screen Range). В автоматическую обработку можно также включить коррекцию гаммы (если необходимо), подавление шума и понижение разрешения до нужной величины. При записи Action необязательно фильтровать все изображение — процесс записи можно ускорить, если фильтровать лишь небольшую выделенную часть. Такой способ записи на качество фильтрации не влияет.

Использование фильтра в составе Action


При запуске фильтра в составе Action следует принять во внимание некоторые особенности, что поможет уменьшить число сбоев и ошибок при пакетной обработке файлов.
Самая ответственная операция в работе фильтра — измерение частоты растра. От правильности ее выполнения зависит вся последующая работа фильтра. Существуют четыре режима определения частоты, в зависимости от того, как был записан Action.
1) Action записан с активированной опцией Automatic. В параметрах Action записано: "With Automatic". В этом случае при каждом выполнении Action частота измеряется заново. Поиск частоты ведется в максимально возможном для обрабатываемого изображения диапазоне (равном D/3 … D/8 lpi, где D — разрешение изображения в ppi). Для повышения надежности измерение будет производиться в нескольких областях изображения, выбираемых случайно. Если частота не будет найдена с должной надежностью, будет выдано сообщение и фильтрация не будет произведена.
2) Action записан с активированной опцией Remove screen, при этом частота и диапазон вручную не изменялись. В параметрах Action записано: "Screen: Auto". В этом случае в отношении измерения частоты выполнение Action происходит также, как в 1).
3) Action записан с активированной опцией Remove screen, при этом диапазон Expected Screen Range задан вручную, а частота измерена автоматически. В параметрах Action записано: "Range Min: …", "Range Max: …", где вместо многоточий стоят конкретные значения. В этом случае в отношении измерения частоты выполнение Action происходит также, как в 1), но поиск ведется в пересечении заданного диапазона с диапазоном D/3 … D/8 lpi, где D — разрешение обрабатываемого изображения в ppi. Если частота не попадает в пересечение или оно пусто, то будет выдано сообщение об ошибке и фильтрация не будет произведена.
4) Action записан с активированной опцией Remove screen, при этом частота задана вручную. В параметрах Action записано: "Screen: …", где вместо многоточия стоит значение частоты. В этом случае измерение частоты не производится, обработка всех изображений ведется с фиксированной частотой. Однако, если эта частота на каком–то изображении не попадет в интервал D/3 … D/8 lpi, будет выдано соответствующее сообщение и фильтрация этого изображения не будет выполнена.
При пакетной обработке большого количества изображений желательно использовать третий вариант, сузив диапазон Expected Screen Range до 0,9*S…1,1*S, где S — ожидаемая частота растра в изображениях. Это уменьшит вероятность, что плагин не сможет измерить частоту в тех изображениях, в которых есть отчетливый растр. При обработке изображений с одинаковой линиатурой (например из одного издания) рекомендуется использовать четвертый вариант (с фиксированной частотой), что еще больше уменьшит вероятность ошибок.
При запуске фильтра в составе Action автоматически выполняется новое измерение углов CMK на каждом изображении (если задана опция Reduce Moire). Для повышения надежности измерение производится в нескольких областях изображения, выбираемых случайно. Если удалось найти только один или два угла из CMK, то оставшиеся полагаются отличным от найденных на 30 градусов. Если не найдено ни одного угла, выдается соответствующее сообщение и фильтрация не производится.
При запуске фильтра в составе Action угол Y не измеряется и подавление розеточного муара в канале Blue не выполняется.

Запуск фильтра через Ctrl+F


При запуске фильтра через Ctrl+F следует принимать во внимание следующие особенности:
Если частота растра была задана вручную (на кнопке измерения частоты есть изображение руки), то фильтрация производится на этой же частоте.
Если частота растра была измерена плагином (на кнопке измерения частоты нет изображения руки), то измеренное ранее значение частоты игнорируется и автоматически выполняется новое измерение частоты. Для повышения надежности измерение производится в нескольких областях изображения, выбираемых случайно. Поиск частоты ведется в диапазоне Expected Screen Range. Если частота не найдена с должной надежностью, выдается сообщение и фильтрация не производится.
Если диапазон Expected Screen Range был задан вручную (об этом свидетельствует изображение руки на кнопке восстановления диапазона), то используется этот диапазон. Если диапазон не был задан вручную, то для каждого изображения будет автоматически использоваться максимально возможный диапазон: D/3 … D/8 lpi, где D — разрешение изображения в ppi.
При запуске фильтра через Ctrl+F каждый раз автоматически выполняется новое измерение углов (если задана опция Reduce Moire). Для повышения надежности измерение производится в нескольких областях изображения, выбираемых случайно. Если удалось найти только один или два угла из CMK, то оставшиеся полагаются отличным от найденных на 30 градусов. Если не найдено ни одного угла, выдается соответствующее сообщение и фильтрация не производится.
При запуске фильтра через Ctrl+F угол Y не измеряется и подавление розеточного муара в канале Blue не выполняется.

Плагин Downsample


Этот плагин входит в дистрибутив фильтра Descreen и доступен через меню File > Automation. Он позволяет понизить разрешение в 2 или 3 раза без образования муара. Путем повторного его применения можно понизить разрешение в 4, 6, 8, 9, 12 и т.д. раз. Его следует применять всегда, когда при понижении разрешения есть опасность возникновения муара из–за наличия каких–либо периодических элементов в изображении — офсетного растра, текстуры тканей, гравюр, мелких изображений лестниц, заборов, зданий и т.п.
Увидеть, что дает понижение разрешения с помощью плагина Downsample, в сравнении со штатной командой Image Size можно из следующего примера. Создайте Grayscale изображение 30х20 мм, 600 ppi. Сделайте горизонтальную градиентную заливку — левый край 100%, правый край 0%. Проведите несколько тонких (толщиной в две точки) кривых линий черного и белого цвета в разных местах изображения. Конвертируйте в Bitmap, указав выходное разрешение 2400 ppi и метод Halftone Screen (Полутоновый растр), линиатура 150, угол 30, круглая растровая точка. Получится растровое изображение. Конвертируйте его в Grayscale 1:1. Сделайте дубликат. Понизьте разрешение обоих изображений до 600 ppi, первого — через Image Size, второго — через Downsample. Удалите растр из обоих изображений фильтром Descreen. Сравните результаты.
Замечание: плагин Downsample, как и другие плагины в разделе Automation, является по сути actions, оформленным для удобства в виде плагина. То есть это набор последовательно выполняемых команд программы Photoshop. В данном случае, при его выполнении используются команды Image Size, Canvas Size и Descreen. Если плагин Descreen не установлен, плагин Downsample не сможет работать. Для отката применения плагина Downsample требуется ведение истории не менее 6 шагов. Однако, при обработке больших изображений ведение истории все же желательно уменьшить до одного шага, чтобы освободить память.



Полезные советы



Измерение частоты и угла наклона растра вручную


Установите просмотр изображения с достаточным увеличением, чтобы были легко различимы отдельные точки офсетного растра. При разрешении изображения 600 ppi достаточно увеличения 300–400%. Выберите участок с хорошо различимым растром, желательно какого–либо одного цвета. Пользуясь инструментом Measure соедините по линии растра какого–либо цвета центры двух растровых точек, отстоящих друг от друга на 20 ячеек. На панели Info отобразятся угол наклона линейки (он будет равен углу данного растра) и расстояние между ее концами в текущих единицах измерения. Разделив 20 на это расстояние, выраженное в дюймах (1 дюйм = 25.4 мм), вы получите частоту растра в линиях на дюйм. Измеренная таким способом частота растра может немного (до 5%) отличаться от измеренной фильтром. Это различие для работы фильтра несущественно (если вы выбираете между этими двумя значениями, выбирайте меньшее). Если вы измерили угол наклона растра одной из красок CMK, то углы наклона растра двух других красок можно принять отличными от измеренной на 30 и 60 градусов.
Если растровые точки сильно размазаны и трудно различимы, сканируйте снова фрагмент изображения с оптическим разрешением сканера. Разрешения 1200 ppi, как правило, достаточно для любого встречающегося на практике растра.
Разумеется, измерить линиатуру и углы наклона можно и прямо на оригинале с помощью специальной линейки (если она у вас есть). Однако, что касается измерения углов, то при этом способе необходимо угловое позиционирование оригинала на сканере с погрешностью не более одного градуса.

Подготовка изображений для офсетной печати


Обычно оказывается достаточным применить только фильтр Descreen к правильно сканированному изображению, чтобы удовлетворительно удалить растр и муар. Однако, чтобы получить наилучший результат можно придерживаться следующего порядка обработки печатных оригиналов.
1. Правильно сканировать оригинал (см. Сканирование оригиналов).
2. Удалить из изображения растр (см. Удаление растра). Если изображение цветное, то одновременно с удалением растра подавить розеточный муар, в том числе в канале Blue (см. Подавление розеточного муара). Если появляется ложный муар, использовать регулировки Sensitivity Light, Sensitivity Dark, Sensitivity Dark и Variant. Если это не решает проблему, применить технику маскирования. В тяжелых случаях применить технику маскирования 3.
3. Убрать шум и остатки муара в канале Blue с помощью штатного фильтра Smart Blur или другого шумоподавляющего фильтра (например плагина Noise Reduction, который бесплатно поставляется с плагином Descreen Professional edition). Даже сильное размывание канала Blue не приводит к потере резкости изображения. Однако, нужно следить за тем, чтобы границы в этом канале не теряли резкость, иначе вокруг них возникнет желтый ореол.
4. Конвертировать изображение в режим Lab в программе Photoshop и убрать шум раздельно по каналам L, a, b с помощью шумоподавляющего фильтра (например плагином Noise Reduction).
5. Выполнить ретуширование, если необходимо.
6. Понизить разрешение изображения до желаемой величины.
7. Убрать, если необходимо, пятна неоднородности с помощью плагина Noise Reduction.
8. Конвертировать изображение в желаемый цветовой режим (RGB или CMYK). Сделать коррекцию цвета, если необходимо. Если в оригинале неидеальное совмещение красок, выполнить коррекцию совмещения (см. Неидеальное совмещение красок в оригинале).
9. Восстановить резкость с помощью стандартных средств Photoshop, например, с помощью Unsharp Mask.
Остаточный розеточный муар. В некоторых случаях приходится идти на компромисс и чтобы сохранить максимум деталей изображения оставлять некоторое количество розеточного муара. В этой связи возникает два вопроса. Первый — насколько остатки розеточного муара будут заметны в напечатанном изображении? Второй — могут ли они, ввиду их периодического характера, давать муар при офсетной печати (при диффузной или стохастической печати никакого муара, конечно, не возникает)? Ответ на первый вопрос: если остатки розеточного муара не видны в программе Photoshop в совмещенном изображении при масштабе 100%, то их не будет видно и в напечатанном изображении (даже если в каналах и на пленках они были сильно заметны). Ответ на второй вопрос: розеточный муар имеет примерно вдвое меньшую частоту, чем растр оригинала, поэтому при печати изображения в масштабе 1:1 остатки розеточного муара не будут интерферировать с новым растром, если частота последнего не меньше частоты исходного растра. Муар может возникнуть, если изображение будет уменьшаться — в этом случае частота остатков розеточного муара увеличивается прямо пропорционально коэффициенту масштабирования и может приблизится к частоте нового растра, в результате чего может возникнуть заметная интерференция. В общем случае, чтобы избежать интерференции можно придерживаться правила: если в изображении есть остатки розеточного муара, то линиатура, с которой оно будет печататься, должна быть не менее 0.8*S/k, где S — линиатура оригинала, k — коэффициент масштабирования. Например, если оригинал имеет линиатуру 150, а изображение планируется увеличить в 1.5 раза, то линиатура должна быть не меньше 80. Если же изображение планируется не увеличивать, а уменьшать, и при этом увеличивать линиатуру нежелательно, то следует более тщательно удалять остатки муара. Последнее при уменьшении изображений обычно не вызывает затруднений.
Выбор фотонабора. Если изображение содержит очень мелкие или резкие элементы, желательно не выводить пленки на фотонаборах Scitex. Эти аппараты дают превосходный результат при работе с их родным форматом файлов Scitex CT, но при выводе из PostScript файлов они сначала преобразуют все полутоновые изображения к разрешению CT Res (внутренний параметр RIP'а, сокращение от Continuous Tone Resolution) и только потом растеризуют их. При этом преобразовании резкие элементы размываются. Разрешение CT Res задается оператором в настройках RIP и обычно не превышает 16 dpm (406.4 ppi) - в документации на фотонаборы Scitex написано, что "для высококачественных изображений достаточно 16 dpm". Для уменьшения размывания можно попросить оператора задать большее разрешение CT Res, например, 20–25 dpm (508–635 ppi). Фотонаборы фирм AGFA и Heidelberg этим недостатком не обладают. Если вы хотите проверить фотонабор на наличие этого дефекта, выведите изображение is_test.tif (входит в дистрибутив) на пленку на полях очередной работы и рассмотрите изображение под лупой. Оно должно выглядеть так же, как в программе Photoshop (все линии должны быть ровными), в противном случае данный фотонабор (точнее его RIP) обладает указанным недостатком. Чтобы не "сгущать краски" вокруг фотонаборов Scitex, следует отметить, что во многих случаях указанным недостатком можно пренебречь, поскольку резкие элементы в изображениях встречаются относительно редко — как правило они размыты на 1–2 пикселя (тем более, если изображения были получены сканированием печатных оригиналов). Резкие элементы обычно исполняются в векторном виде (шрифты, графика) или имеют формат Bitmap. Векторные элементы и формат Bitmap фотонаборы Scitex обрабатывают корректно и потери резкости здесь не возникает.
Выбор углов растров. Уменьшить образование розеточного муара можно путем выбора оптимальных углов наклона растров. В этой связи см. Цветная растровая печать.
Эллиптический растр. При выводе пленок правильное использование эллиптических растровых точек позволяет получить менее заметный розеточный муар, чем при круглых растровых точках. Правильность заключается в правильном задании углов. Если углы выбрать неправильно, муар будет, наоборот, сильнее (характерным признаком ошибки является наличие в муаре наклонных линий). Основной принцип здесь такой: выбрать углы так, чтобы углы между длинными полуосями эллипсов были максимальными — при этом уменьшается площадь пересечения растровых точек, а следовательно и муар. Чтобы реализовать этот принцип можно следовать правилу: для красок CMK взять углы C15, M75, K135, а при выборе угла желтой краски брать 120 градусов, если в изображении красных цветов больше чем зеленых, и 150 градусов, если наоборот. Следует помнить, что при эллиптических растровых точках изменение угла какой–либо краски на 90 градусов влияет на результат. В частности, если вместо C15, M75, Y120, K135 взять C15, M75, Y120, K45, то муар будет сильнее, чем при круглых растровых точках. Заметный эффект от использования эллиптических точек достигается при довольно вытянутых эллипсах (отношение полуосей 3 и более). При увеличении вытянутости точек растр приближается к линейчатому. К сожалению, чем более вытянуты точки, тем больше величина растискивания. Последнее обстоятельство ограничивает широту применения эллиптического растра (а также прочих некруглых растров). По–видимому, применять эллиптический растр наиболее уместно при печати изображений с большими однотонными участками, на которых желательно уменьшить розеточный муар.

Применение фильтра для внесения изменений в фотонаборные пленки


Иногда возникает необходимость внести изменения в уже выведенные пленки. Когда нет возможности изготовить их заново, приходится использовать CopyDot + Descreen технологию. Суть ее заключается в том, что сначала пленки сканируют с большим разрешением, затем удаляют растр, вносят необходимые изменения и выводят новые пленки. При этом, естественно, происходит некоторая потеря качества и задача заключается в том, чтобы сделать ее минимальной. Кроме того, необходимо избежать появления муара, который склонен возникать при сканировании и обработке пленок, содержащих растр. CopyDot + Descreen технология реализована в программном обеспечении некоторых продвинутых профессиональных сканеров, в частности, сканерах фирм Esko–Graphics и Heidelberg. Ниже описан метод, позволяющий получить качественный результат, используя Photoshop и фильтр Descreen.
1. Сканируйте пленки, следуя рекомендациям раздела Сканирование высококачественных оригиналов.
2. Понизьте разрешение изображения с помощью плагина Downsample, чтобы оно попало в интервал 4*S…8*S ppi, где S — линиатура растра в lpi.
3. Удалите растр фильтром Descreen. Значение Sharpness можно взять равным 0.

Прочие советы


• Неидеальное совмещение красок в оригинале. При обработке цветных изображений с неидеальным совмещением красок несовмещение можно ослабить путем сдвига цветовых каналов (относительно друг друга) в режиме CMYK. Это следует делать на отфильтрованном изображении (иначе фильтр будет неправильно работать).
• Коррекция гаммы. При сканировании печатных оригиналов можно и даже желательно использовать коррекцию гаммы. Этот параметр не влияет на качество удаления растра, но оказывает влияние на удаление розеточного муара в областях с насыщенным цветом. Обычно его выбирают равным 1.8, но, возможно, на вашем сканере наиболее полное удаление розеточного муара получится при каком–то другом значении (его достаточно определить один раз и в дальнейшем использовать для сканирования всех цветных печатных изображений). Если ваш сканер не позволяет корректировать параметр гаммы при сканировании, это можно сделать после сканирования в программе Photoshop командой Image > Adjustments > Levels, изменяя положение среднего ползунка под гистограммой.
• Техника маскирования. Если одни области изображения лучше получаются фильтрацией с одними параметрами, а другие — с другими, можно поступить стандартным для Photoshop'а способом: сделать два (или более) слоя, отфильтровать каждый с нужными параметрами, а затем скомбинировать слои, используя маскирование, так чтобы выбрать с каждого слоя лучшее. Например, если на верхнем слое некоторые области получились лучше, чем на нижнем, то следует присоединить к верхнему слою маску (Layer > Add Layer Mask > Hide All) и вручную закрасить ее (она находится в каналах) белой кистью, чтобы открыть нужные элементы на верхнем слое.
• Техника маскирования 2. Если изображение отфильтровано в целом удовлетворительно за исключением небольшой области, необязательно фильтровать заново все изображение. Сделайте копию (Image > Duplicate) изображения и верните оригинал к исходному состоянию. Выделите все отфильтрованное изображение, скопируйте его в буфер, затем выделите весь оригинал изображения и вставьте изображение из буфера. Оно должно разместиться как дополнительный слой, точно совмещенный с первым. Выделите неудовлетворительно отфильтрованную область на нижнем слое и примените Descreen с подходящими установками. Используя маскирование на верхнем слое скомбинируйте два изображения для получения нужного результата.
• Техника маскирования 3. Если техника маскирования применяется для устранения ложного муара, то ее можно дополнить обработкой проблемных элементов: скопления мелких деталей и четких линий, параллельных линиям растра. Для примера возьмем случай, когда мелкий текст расположен в области с растром, и при удалении розеточного муара вокруг этого текста возникает ложный муар. С помощью команды Select > Color Range следует выделить шрифт (в случае других проблемных элементов иногда приходится выделять их вручную, но суть метода от этого не меняется). Чтобы полностью захватить проблемную область, применить команду Select > Modify > Expand величиной 3 пикселя. Затем использовать команду Select > Feather величиной 1 пиксель для смягчения краев. Теперь применить Descreen без удаления розеточного муара (флажок Reduce Moire снят). Снять выделение и применить Descreen с удалением розеточного муара.
• Восстановление резкости. После удаления шума из изображения или понижения разрешения до требуемого бывает полезным повысить его резкость с помощью Unsharp Mask. Эту операцию можно применять дважды: первый раз для оттенения границ, а второй — для их обострения. Например, сначала операция применяется с параметрами Amount = 20, Radius = 5.0, а потом с Amount = 100, Radius = 1.0. Для ориентира можно следовать правилу: произведение Amount*Radius должно оставаться примерно равным 50–200. 
• Точный подбор регулировок. При подборе значений на ползунках можно пользоваться стрелками на клавиатуре для более точного позиционирования.
• Краски Pantone. Если изображение содержит краски, отличные от CMYK (например краски Pantone), необходимо выбрать три наиболее темные краски, измерить вручную их углы (если этого не сделал плагин) и ввести в ячейки СМК. Если краской Pantone напечатан не растр, а сплошные элементы, то на данную краску при удалении растра можно не обращать внимания.
• Понижение разрешения изображения, из которого был удален растр, вплоть до 2*S ppi, где S — линиатура исходного изображения в lpi, не вызывает потери какой–либо информации, содержащейся в нем.
• Сохранение резкости графических элементов при удалении растра. При удалении растра из изображений с графическими элементами, которые желательно сохранить резкими, например, текстом, целесообразно использовать технику маскирования (см. выше).
• Точное воспроизведение печатных оригиналов. Существует экстремальный способ точно воспроизвести растровое печатное изображение в масштабе 1:1. Сканируйте изображение с разрешением сканирования 4*S…6*S ppi, где S — линиатура изображения в lpi. (Учтите предостережения, указанные в разделе Сканирование высококачественных растровых оригиналов и если необходимо используйте большее разрешение). Примените фильтр Descreen c регулировкой Screen, равной 1.3*S…1.4*S. При этом регулировкой Sharpness выставьте желаемую резкость, а флажок Reduce Moire снимите. В результате фильтрации в изображении сохранится отчетливый растр, но без высокочастотных гармоник. Изображение следует использовать в таком виде без какого–либо масштабирования. Немного осветлите его для компенсации затемнения при печати (величина компенсации подбирается опытным путем). Изображение следует выводить с линиатурой не менее 2*S (или использовать диффузный растр), на устройстве с разрешением не менее 2400 ppi (не выводить на фотонаборах Scitex — см. выше). В результате при печати получится изображение с линиатурой, равной исходной. Иными словами, в изображении будут сохранены все его растровые точки. Однако, если это цветное изображение, то выводить его можно только на устройстве с очень точным совмещением цветов, например, на цифровом офсете или принтере. Второй недостаток этого способа заключается в том, что точно воспроизводится не только изображение, но и шум. Поскольку при печати добавляется новый шум, то вновь напечатанное изображение будет выглядеть более шумным, чем исходное. Для уменьшения этого дефекта можно попробовать удалить пятна неоднородности с помощью плагина Noise Reduction (покупается отдельно, с Descreen Professional edition поставляется бесплатно).



Разрешение проблем




	Проблема
	Пояснения и рекомендации



	Не удается измерить частоту растра с помощью кнопки измерения частоты ни в каких областях изображения. При измерении всегда получается ноль.
	Восстановите диапазон Expected Screen Range, нажав кнопку восстановления диапазона и повторите попытку. Если это не помогает, рассмотрите следующие версии. 1) В изображении нет растра и следовательно нечего измерять. 2) Растр есть, но недостаточно отчетлив. Если это так, тогда установите частоту растра вручную с помощью ползунка Screen, предварительно измерив ее (см. описание процедуры измерения). 3) Проверьте разрешение изображения — оно должно быть в диапазоне 3*S … 8*S ppi, где S — частота растра в lpi. Если необходимо, сканируйте изображение заново с правильным разрешением, см. Сканирование оригиналов. 4) Если предыдущие версии оказались неправильными, то возможно изображение было неправильно сканировано. См. Сканирование оригиналов и О факторах, влияющих на качество результата.



	Не удается измерить углы растра с помощью кнопки измерения углов ни в каких областях изображения.
	Это может произойти по нескольким причинам. 1) Неправильно задана или измерена частота растра. Чтобы быть уверенным, что частота задана правильно, измерьте ее вручную (см. описание процедуры измерения). 2) Растр недостаточно отчетлив. Введите углы вручную, предварительно измерив их (см. описание процедуры измерения). Следует иметь ввиду, что подавление розеточного муара должно производиться одновременно с удалением растра. Функция подавления муара не будет правильно работать, если в изображении отсутствует растр (например, если он был ранее удален). 3) Изображение было неправильно сканировано. См. Сканирование оригиналов. Если эта ситуация часто повторяется на разных изображениях, то возможно сканер не обеспечивает достаточного качества (см. О факторах, влияющих на качество результата).



	Измерение частоты кнопкой измерения частоты дает неправильный результат (значение сильно завышено или занижено).
	Обычно это случается, когда диапазон поиска линиатуры Expected Screen Range слишком широк и в него попадает не только сам растр, но и его гармоники или другие спектральные составляющие изображения, которые плагин может по ошибке принять за растр. Для того, чтобы облегчить плагину измерение линиатуры, желательно сузить диапазон поиска хотя бы до 0,7*S…1,3*S, где S — ориентировочная частота растра. Если это не помогает, то возможно, изображение было неправильно сканировано. См. Сканирование оригиналов и О факторах, влияющих на качество результата.



	При подавлении розеточного муара он остается заметным в некоторых областях.
	Нормальным является уровень остаточного муара сопоставимый с уровнем шума (зернистостью). Если остаточный муар заметно больше уровня шума, то возможными причинами этого являются: 1) Чувствительность, заданная регулировками Sensitivity Dark, Sensitivity Light и Sensitivity Blue не подходит для данного изображения. Попробуйте изменять эти регулировки. Попробуйте также изменить регулировку Variant. Если все это не помогает верните регулировки в исходное (среднее) положение. 2) Неправильно заданы углы. Задайте их правильно. 3) Проверьте нет ли клиппинга в каналах изображения. Если есть, сканируйте изображение заново. Убедитесь, что системы управления цветом при сканировании не вносят изменения в изображение, см. Сканирование оригиналов. Попробуйте также использовать коррекцию гаммы.



	При подавлении розеточного муара он усиливается в некоторых областях или появляется там, где его не было.
	см. Ложный муар.



	Другая проблема
	Обратитесь за технической поддержкой.






	Сообщения
	Пояснения и рекомендации



	"Could not complete the Descreen command because the error #N. Please contact the plug–in developer."
	"Не удается выполнить команду Descreen поскольку случилась ошибка #N. Обратитесь к разработчику." Случилась внутренняя ошибка плагина. Для ее устранения следует переустановить плагин. Если это не помогает, запишите номер ошибки и обратитесь к разработчику.



	"Could not complete the Descreen command because the image resolution D ppi is too high."
	"Не удается выполнить команду Descreen поскольку разрешение D изображения слишком высокое." Следует понизить разрешение в два раза. Если это сообщение появится снова, понизьте разрешение еще раз и т.д. См. также Сканирование оригиналов.



	"Could not complete the Descreen command because the image resolution D ppi is too low."
	"Не удается выполнить команду Descreen поскольку разрешение D изображения слишком низкое." Следует заново сканировать изображение с разрешением 600…1200 ppi. См. также Сканирование оригиналов.



	"Could not complete the Descreen command because the manual screen S is out of the range A… B lpi."
	"Не удается выполнить команду Descreen поскольку заданная вручную частота растра S лежит вне допустимого диапазона A…B lpi." Это сообщение выдается при выполнении плагина в составе actions с фиксированной частотой. Попробуйте обработать изображение в обычном режиме. Если в обычном режиме не удается измерить частоту (в том числе с помощью кнопки измерения частоты), то см. соответствующий раздел Разрешения проблем.



	
	Если вы хотите добиться обработки изображения в составе actions, тогда сделайте следующее. Если S задано правильно (т.е. равно реальной линиатуре изображения) и S<A, тогда следует понизить разрешение изображения до 4*S ppi. Если S задано правильно и S>B, тогда следует заново сканировать изображение с разрешением около 4*S. Если S задано неправильно, задайте правильное значение и повторите попытку. См. также Сканирование оригиналов и Expected Screen Range.



	"Could not complete the Descreen command because the moire reducing is available in RGB mode only."
	"Не удается выполнить команду Descreen поскольку уменьшение муара возможно только в режиме RGB." Если изображение цветное, то для использования опции уменьшения муара его следует конвертировать в режим RGB. Если уменьшение муара не требуется, опцию Reduce Moire следует отключить (см. Reduce Moire).



	"Could not complete the Descreen command because the screen angles have not been found at S lpi screen."
	"Не удается выполнить команду Descreen поскольку не удалось измерить углы растра при частоте растра S lpi." Это сообщение выдается, когда плагин выполняется в составе actions и плагину удалось найти менее 2 углов. Возможны следующие причины. 1) Если плагин выполнялся в составе actions с фиксированной частотой, то проверьте соответствует ли она частоте растра обрабатываемого изображения. Для этого измерьте ее с помощью кнопки измерения частоты или вручную (см. описание процедуры измерения). 2) В изображении отсутствуют две краски из CMK (например присутствуют только MY). Изображения с отсутствующими красками не следует обрабатывать через actions (см. Actions). 3) Растр неотчетлив. В этом случае введите частоту растра и углы вручную, предварительно измерив их (см. описание процедуры измерения). 4) Если эта ситуация часто повторяется на разных изображениях, то возможно неправильно выполняется сканирование или сканер не обеспечивает достаточного качества (см. Сканирование оригиналов и О факторах, влияющих на качество результата).



	"Could not complete the Descreen command because the screen has not been found within the range A…B lpi."
	"Не удается выполнить команду Descreen поскольку не удалось измерить частоту растра внутри диапазона A…B lpi." Это сообщение выдается при выполнении плагина в составе actions, если внутри указанного диапазона плагин не смог с должной достоверностью определить частоту растра. Попробуйте обработать изображение в обычном режиме. Если в обычном режиме не удается измерить частоту (в том числе с помощью кнопки измерения частоты), то см. соответствующий раздел Разрешения проблем. Если вы хотите добиться обработки изображения в составе actions, тогда рассмотрите следующие варианты. 1) Частота растра не попадает в указанный диапазон. Чтобы проверить это, измерьте частоту растра с помощью кнопки измерения частоты или вручную (см. описание процедуры измерения). Затем проверьте разрешение изображения — оно должно быть в диапазоне 3*S … 8*S ppi, где S — частота растра в lpi. Если это так, то измените диапазон A…B (заданный в Expected Screen Range), чтобы растр попадал в него. Если это не так, то сканируйте изображение заново с правильным разрешением, см. Сканирование оригиналов. 2) Растр недостаточно отчетлив для надежного измерения, например, в изображении много областей со слабым или вовсе отсутствующим растром — черных или белых областей. Такие изображения придется обрабатывать отдельно в обычном режиме. 3) Диапазон A…B слишком широк и в него попадает не только сам растр, но и его гармоники и плагин не смогла с достаточной надежностью отличить одно от другого. Если планируется обработать большое количество изображений, то для того, чтобы облегчить плагину измерение линиатуры, желательно сузить диапазон Expected Screen Range, см. Использование фильтра в составе Action.



	"The image resolution D ppi is too high."
	"Разрешение D изображения слишком высокое." Следует понизить разрешение в два раза. Если это сообщение появится снова, понизьте разрешение еще раз и т.д. См. также Сканирование оригиналов.



	"The image resolution D ppi is too low."
	"Разрешение D изображения слишком низкое." Следует заново сканировать изображение с разрешением 600…1200 ppi. См. также Сканирование оригиналов.



	"The resolution of the image is D ppi. It is too high to remove screen. If you know approximate screen frequency, enter it manually and press the "Info" button for the additional information. Otherwise, downsample the original image to 800 ppi."
	"Разрешение изображения D ppi. Оно слишком высоко для удаления растра. Если вы знаете приблизительную величину частоты растра, введите ее вручную и нажмите кнопку Info для получения дополнительной информации. Иначе понизьте разрешение до 800 ppi." Изображение было сканировано с завышенным разрешением, см. Сканирование оригиналов.



	"The resolution of the image is D ppi. It is too low to remove screen. If you know approximate screen frequency, enter it manually and press the "Info" button for the additional information. Otherwise, rescan the original image at 600…1200 ppi"
	"Разрешение изображения D ppi. Оно слишком низко для удаления растра. Если вы знаете приблизительную величину частоты растра, введите ее вручную и нажмите кнопку Info для получения дополнительной информации. Иначе сканируйте изображение заново с разрешением 600 ppi…1200 ppi." Изображение было сканировано с недостаточным разрешением, см. Сканирование оригиналов.



	"The screen angles have not been found at S lpi screen."
	"Не удалось измерить углы растра при частоте растра S lpi." Это сообщение выдается, когда плагин выполняется в режиме Automatic или запускается через Ctr+F и ему удалось найти менее 2 углов. Возможны следующие причины. 1) В изображении отсутствуют две краски из CMK (например присутствуют только MY. Изображения с отсутствующими красками не следует обрабатывать в режиме Automatic или через Ctr+F. 2) Растр неотчетлив. В этом случае введите углы вручную, предварительно измерив их (см. описание процедуры измерения). 3) Если эта ситуация часто повторяется, то возможно неправильно выполняется сканирование (см. Сканирование оригиналов и О факторах, влияющих на качество результата).



	"The screen has not been found within the range A…B lpi."
	"Не удалось измерить частоту растра внутри диапазона A…B lpi." Это сообщение выдается, когда плагин выполняется в режиме Automatic или запускается через Ctr+F и ему не удается определить частоту растра внутри указанного диапазона. Попробуйте обработать изображение в обычном режиме. Если в обычном режиме не удается измерить частоту (в том числе с помощью кнопки измерения частоты), то см. соответствующий раздел Разрешения проблем.






Словарь


Клиппинг — эффект, при котором некоторые участки изображения становятся окрашенными в сплошной цвет. Клиппинг может возникать при сканировании из–за неправильного выбора диапазона плотностей. Проверить наличие или отсутствие клиппинга можно с помощью построения гистограммы изображения.
Линиатура — см. Частота растра.
Линии растра — Ячейки растра, соприкасающиеся сторонами и расположенные на одной линии образуют линии растра (см. рис. 8).
Муар — периодическая структура, возникающая при наложении периодических структур, например, растров. Частота муара равна разности частот накладываемых структур.
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Рис. 7. Примеры образования муара. На двух нижних изображениях разница в образовании муара связана с разными взаимными углами накладываемых структур: слева — 15, справа — 45 градусов.
Оптическое разрешение сканера — указанное в паспорте максимальное разрешение сканера, при котором не используется интерполяция; измеряется в ppi (пикселях на дюйм). Сканирование с разрешением больше оптического не дает дополнительных деталей изображения (с таким же или даже большим успехом можно сканировать изображение с оптическим разрешением, а затем повышать разрешение в программе Photoshop, используя бикубическую интерполяцию). Для удаления растра фильтром Descreen оптическое разрешение сканера должно превышать линиатуру сканируемого изображения минимум в 4 раза. Сканирование с разрешением больше оптического к повышению качества не приведет. Оптическое разрешение сканера обычно хуже его реальной разрешающей способности.
Офсетная печать — способ печатания, при котором краска с печатной формы передаётся под давлением на промежуточную эластичную поверхность, а с неё на бумагу или другой печатный материал. Печатную форму (обычно металлическую) изготавливают следующим путем. В специальном аппарате к форме плотно прижимают пленку с изображением и засвечивают со стороны пленки. Затем форму травят в специальном растворе, в результате чего незасвеченные участки оказываются способными принимать печатную краску (становятся печатными элементами), а засвеченные — нет (становятся пробельными элементами). В процессе печати краска наносится на печатную форму тонким слоем равной толщины. Краска прилипает к печатным элементам и затем переносится на оттиск. В результате образуется изображение, состоящее из двух градаций цвета — "краска нанесена" и "краска не нанесена". Это изображение не содержит полутонов (промежуточных градаций цвета). Для имитации полутонов в офсетной печати применяют растрирование изображения.
Оцифровка сигналов — преобразование непрерывных сигналов в цифровую форму. Примеры: цифровая запись музыки, сканирование, цифровая фотография. Осуществляется снятием отсчетов сигнала через равные интервалы (времени или пространства).
 Для оцифровки важно правильно выбрать интервал оцифровки и глубину разрядности (число битов в отсчетах). Разрядность определяет число градаций оцифрованного сигнала — чем она выше, тем точнее передается исходный сигнал. В случае сканирования оно обычно составляет 8 бит (256 градаций) на каждый цвет. В случае записи музыки СD–качества — 16 бит (65536 градаций) на каждый канал. С выбором интервала оцифровки дело обстоит немного сложнее — он определяет максимальную частоту, которая может быть правильно передана при оцифровке. Согласно известной теореме Найквиста–Котельникова (1928–1933), если максимальная встречающаяся в сигнале частота равна F, то для точной его оцифровки необходимо, чтобы интервал оцифровки был не более 1/(2*F). Теорема утверждает, что если сигнал оцифрован с таким интервалом и глубина разрядности равна бесконечности, то исходный сигнал может быть в точности восстановлен по его записи. В случае записи музыки CD–качества оцифровка производится с частотой 44100 отсчетов в секунду. Это позволяет правильно записывать звуки, частота которых не превышает 22050 Гц. Если в сигнале окажется частотная составляющая выше 22050 Гц, скажем, 22050+A, она будет записана как частота 22050–A. Например, если A будет равно 21900 Гц, то в записи получится составляющая 150 Гц. При воспроизведении она будет слышна как посторонний призвук. Чтобы этого не происходило приходится круто обрезать высокие частоты перед оцифровкой. Однако, и то и другое приводит к характерной для CD шепелявости на высоких частотах. Записи Super Audio CD и DVD Audio с частотой 96000 Гц и выше этим дефектом уже не обладают.
 Механизм понижения частоты легко понять на примере оцифровки обычной синусоиды — если частота отсчетов меньше частоты синусоиды более чем в два раза (то есть на один период приходится менее двух отсчетов), то оцифровка может иметь частоту ниже частоты синусоиды. Например, если частота оцифровки равна частоте синусоиды, отсчеты будут производится в одном и том же месте периода синусоиды и оцифровка будет иметь вовсе нулевую частоту (постоянный сигнал). Таким образом, если на вход оцифровывающего устройства с частотой отсчетов F подать сигнал частотой G, то на выходе будет получаться следующее. Пока G<F/2, сигнал на выходе будет иметь ту же частоту, что и на входе. Если G превысит F/2, выходной сигнал будет иметь частоту F–G. При дальнейшем повышении частоты входного сигнала частота выходного сигнала будет уменьшаться, пока не дойдет до нуля, после чего она снова начнет увеличиваться. Проще говоря, по мере увеличения частоты входного сигнала частота выходного сигнала доходит до F/2, заворачивается и идет назад к нулю, дойдя до нуля снова заворачивается и идет обратно к F/2 и так далее.
 Применительно к сканированию теорема Найквиста–Котельникова означает, что разрешение сканирования должно по меньшей мере в два раза превышать максимальные пространственные частоты, встречающиеся в изображении. В противном случае эти частоты "завернуться" и окажутся в области более низких частот. Если они дойдут до окрестности низких частот, они станут особенно заметны. Визуально это будет выглядеть как муар (фактически, это и есть муар, возникающий из–за интерференции высоких частот изображения со сканирующей линейкой сканера). Если амплитуда этих частот не велика, муар будет незаметен. Однако, бывают случаи, когда амплитуда высокочастотных составляющих весьма велика и пренебречь ею нельзя. Например, в спектре изображения, напечатанного офсетным растром, имеются высокие пики на частоте растра, а также на частотах, кратных ей (расположение гармоник в спектре изображено на рис. 9а). Наихудшим случаем (в отношении возникновения муара), является сканирование такого изображения с разрешением сканирования, близким к частоте растра и нулевым углом наклона растра к линейке сканера — при этом в сканированном изображении основной пик растра оказывается в районе нуля, что выглядит как очень сильный муар. Аналогичная ситуация будет возникать, если разрешение сканирования будет близко к частоте одной из гармоник растра. Для правильного сканирования необходимо, чтобы гармоники растра не только не оказывались в области нуля, но и не попадали в область с полезной информацией изображения, расположенной в частотном диапазоне от нуля до первой гармоники (изображена белым кругом на рис. 9а). Здесь важно то, то что амплитуда гармоник с ростом их частоты уменьшается. Скорость спада тем больше, чем меньше резкость краев растровых точек. При резких краях растровой точки значимую амплитуду могут иметь даже гармоники с частотой до 15*S, где S — частота растра. Например, такое бывает, если сканируемым оригиналом являются фотонаборные пленки. Поскольку гармоники с ростом частоты спадают, всегда можно выбрать достаточно большую частоту сканирования, чтобы они не попадали в область с полезной информацией изображения. Если для примера взять случай, когда все гармоники с частотой выше 15*S равны нулю (или пренебрежимо малы в сравнении с шумом), то для того, чтобы значимые гармоники при "заворачивании" не попали в область с полезной информации изображения, разрешение сканирования должно быть не менее 16*S. Если края растровых точек размыты (в самом оригинале или путем оптической расфокусировки сканера), так что всеми гармониками с частотой выше 3*S можно пренебречь, то для правильного сканирования достаточно разрешения 4*S.
 Понижение разрешения можно рассматривать как частный случай оцифровки, а именно, как прореживание исходных отсчетов. Здесь действуют те же правила. В частности, чтобы избежать появления муара при понижении разрешения необходимо предварительно удалить верхние частоты. В противном случае они могут "завернуться" и образовать муар. Понижение разрешения с учетом этого требования выполняется плагином Downsample.
Розеточный муар — муар, возникающий при цветной растровой печати из–за наложения растров различных красок. При типичных значениях углов наклона растров этот муар по виду напоминает розетки и поэтому так и называется (см. пример на рис. 3). Наиболее заметен муар, возникающий между темными красками: голубой, пурпурной и черной. При сканировании цветных печатных изображений приходится помимо удаления растра принимать также меры по подавлению розеточного муара.
Разрешающая способность сканера — характеризует способность сканера различать близкорасположенные линии. Определяется как минимальная частота тестового изображения (см. далее), при котором его линии не различаются сканером (то есть в отсканированном тестовом изображении они выглядят как сплошной фон). Тестовое изображение состоит из параллельных прямых черных линий равной толщины с расстоянием между линиями, равным их толщине. (На практике в качестве тестового изображения используется один клин из сходящихся линий — так называемая "мира"). Его частотой называется число линий в одном дюйме. Разрешающая способность сканера лишь в идеале равна его паспортному оптическому разрешению. У реальных сканеров разрешающая способность ниже паспортного оптического разрешения (чем качественнее сканер, тем меньше различие).
Растрирование — преобразование исходного изображения в изображение с периодической структурой, состоящей из однотипных ячеек одинакового размера. В большинстве случаев ячейки имеют квадратную форму, и везде в данном описании подразумевается именно эта форма. Примеры: мозаика из прямоугольных плиток, отображение фотографии на экране монитора пикселями, сканирование. В офсетной печати растрирование используется для передачи полутонов (промежуточных градаций цвета). При этом применяется особый вид растрирования, в котором каждая ячейка состоит только из двух цветов. Например, при черно–белой офсетной печати каждая ячейка состоит только из белого и черного. Ячейки имеют малый размер: 0.1–0.5 мм. Поэтому частично заполненные черным цветом ячейки воспринимаются глазом как серые. Это позволяет передавать полутона изображения, используя только черную краску. Наблюдаемый оттенок серого цвета определяется отношением площади, занимаемой черным цветом, к площади ячейки. При этом расположение черной краски внутри ячейки, вообще говоря, может быть любым. На практике оно выбирается таким образом, чтобы его легче было напечатать. Как правило, используют круг или эллипс, расположенный в центре ячейки. При необходимости круг обрезается, чтобы заполнить большую часть ячейки или чтобы точнее передать форму растрируемого изображения. Если принять белый цвет за 0%, а черный — за 100%, то оттенок серого в 10% после такого растрирования будет выглядеть как круги с диаметром, равным 0.36 расстояния между их центрами (см. рис. 8). Иногда применяется стохастическое растрирование. В принтерах оно называется диффузным. В этом случае каждая ячейка заполняется не одним пятном, а множеством маленьких пятен. Стохастическое растрирование позволяет получить более ровные оттенки полутонов и полностью устранить розеточный муар. Однако, оно предъявляет высокие требования к качеству печатного процесса и поэтому не имеет широкого распространения в офсетной печати. Получить наглядные примеры растрирования можно в программе Photoshop. Для этого откройте небольшое Grayscale–изображение и конвертируйте его в Bitmap, указав метод «Halftone Screen» («Полутоновый растр») и задав выходное разрешение 2400 ppi.
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Рис. 8. Пример растрирования (увеличено в 30 раз): вверху — исходное изображение с полутонами 10%, 30%, 50% и 70%, внизу — результат растрирования (круглая растровая точка, угол наклона линий растра 15 градусов). Отмечена одна линия растра. Примеры реальных растровых точек см. на Рис. 6.
Растр — результат растрирования. Параметрами растра являются: линиатура, угол наклона и тип растра (способ растрирования).
Печатный муар — см. Розеточный муар.
Угол растра — угол наклона линий растра. Поскольку любые две линии растра либо параллельны, либо перпендикулярны друг другу, то для однозначного задания угла их наклона достаточно указать наклон какой–либо одной линии в интервале от 0 до 90 градусов. Значения, большие 90 градусов или меньшие 0, приводятся к этому интервалу путем вычитания или прибавления 90 градусов. При многокрасочной печати углы растров красок подбираются таким образом, чтобы розеточный муар был наименее заметен. Для этого разность между углами должна быть максимальной. 
Удаление растра из сканированного печатного изображения выполняется с целью предотвращения появления муара. Рассмотрим однокрасочное печатное изображение, сканированное в режиме Grayscale. Частотный спектр такого изображения содержит высокий пик на частоте растра, а также пики на более высоких частотах (см. рис. 9). При выводе изображения на растровое устройство (дисплей, принтер или фотонабор) с частотой растра близкой к одному из этих пиков, будет возникать муар. Чтобы муар не появлялся ни при каких обстоятельствах, все эти пики необходимо удалить. Фильтр Descreen удаляет из спектра изображения все частоты, равные или превышающие частоту растра (пример см. на рис. 2). 
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Рис. 9. Спектр изображения:
a) Область с основной информацией изображения.
b) Область с пиками растра и его гармоник, удаляемая фильтром.
Граница областей находится чуть ниже частоты растра.
В действительности, спектр изображения является двухмерным и спектральные пики растра расположены в точках с координатами (n*S, m*S), где S — частота растра, а n и m — целые числа. На рис. 9 этот двумерный спектр изображен лишь в радиальной координате. Первый пик, изображенный на рис. 9, соответствует точкам (1,0), (0,1), (-1,0), (0, — 1), его частота равна S. Второй пик соответствует точкам (1,1), (-1,1), (-1, — 1), (1, — 1), его частота равна 1.41*S. Эти два пика обычно имеют наибольшую амплитуду. Амплитуда остальных пиков (гармоник растра) постепенно спадает по мере роста их частоты. Скорость спада амплитуды с ростом частоты зависит от резкости краев растровой точки — чем меньше резкость, тем быстрее спад.

[image: ]


Рис. 9а. Двухмерный спектр растра. За единицу принята частота растра S.
Цветная растровая печать — заключается в последовательном нанесении на бумагу (или другой носитель) красок, каждая из которых накладывается в виде растра. В большинстве случаев применяется печать четырьмя красками: Cyan (голубой), Magenta (пурпурной), Yellow (желтой) и Black (черной), обозначаемых также аббревиатурой CMYK (Буква B не используется, чтобы не путать ее с Blue в аббревиатуре RGB). Частоты растров всех красок обычно одинаковы. Углы наклона растров подбираются таким образом, чтобы свести к минимуму интерференцию растров различных красок (розеточный муар).
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Рис. 10. Пример цветной растровой печати.
В общем случае, розеточный муар наименее заметен, если углы между темными красками CMK максимальны (и следовательно равны 30 градусам), а желтая краска находится посередине между двумя из них, например: C15, M75, Y90, K45 (желтая краска находится между голубой и пурпурной). Для уменьшения муара желательно, чтобы желтая краска была чистой (без темных примесей) и расположена между наименее интенсивными красками. Например, если печатаются лица людей, то желтую краску желательно поместить между черной и голубой, а если лесные пейзажи, то между пурпурной и черной. Распространенный способ уменьшения муара — использование растровой точки эллиптической (см. Эллиптический растр) или линейчатой формы. Иногда для уменьшения розеточного муара частоты растров делают немного различными или применяют более сложные приемы, например, изменение частоты растра или формы растровой точки в зависимости от оттенка цвета. Все эти меры уменьшают, но полностью не устраняют муар и в отпечатанных изображениях он проявляется характерным розеточным паттерном. При выборе углов растра остается некоторый произвол — все углы можно повернуть на одну и ту же величину и взаимное расположение красок от этого не изменится. На практике этот произвол устраняется дополнительными соображениями, например, тем, что для уменьшения зубчатости вертикальных и горизонтальных краев черных элементов, желательно, чтобы черная краска была равна 45 градусов.
Частота растра (линиатура) - число линий растра, умещающихся в 1 дюйме (25.4 мм). Обозначается lpi (англ. «lines per inch»). Чем выше частота растра, тем лучше могут быть переданы мелкие детали и тем менее растр заметен для глаза. Однако для печати с высокими частотами растра требуются качественные бумага, краски и печатное оборудование. Некоторые типичные значения линиатуры: уличные плакаты — 35–120 lpi; газеты — 50–150 lpi; журналы и книги — 100–175 lpi; открытки, альбомы по искусству и высококачественные рекламные материалы — 150–250 lpi, почтовые марки и ценные бумаги — более 300 lpi. Наряду с единицей lpi используются также lpm (линии на миллиметр) и lpc (линии на сантиметр). 



Названия некоторых стандартных терминов программы Photoshop в ее русскоязычных версиях:




	Action
	панель "Действия", "Скрипты"



	Add Layer Mask
	группа команд "Добавить маску" в меню "Слой"



	Adjust
	группа команд "Установка" в меню "Изображение"



	Automate
	группа команд "Автоматизация" в меню "Файл"



	Batch
	команда "Пакет" в меню "Файл > Автоматизация"



	Bitmap
	режим "Битовый"



	Blur
	фильтр "Смазывание", "Размывание"



	Canvas Size
	команда "Размер холста", "Размер полотна"



	Desaturate
	команда "Обесцветить" в меню "Изображение > Установка"



	Despeckle
	фильтр "Убрать пятна"



	Equalize 
	команда "Уровнять" в меню "Изображение > Установка"



	Find Edges 
	фильтр "Вычисление краев"



	Gaussian blur
	фильтр "Смазывание Гаусса", "Размывание Гаусса"



	Grayscale
	режим "Черно–белый"



	Halftone Screen
	"Полутона"



	Hi Pass
	фильтр "Высокая передача"



	Hide All
	команда "Скрыть все" в меню "Слой > Добавить маску"



	Image
	меню "Изображение"



	Image size
	Команда "Размер" меню "Изображение"



	Info
	панель "Информация"



	Layer
	меню "Слой"



	Levels
	команда "Уровни" в меню "Изображение > Установка"



	Measure tool
	инструмент "Измерение"



	Median
	фильтр "Серединный"



	Nearest Neighbor
	тип масштабирования (метод интерполяции) "По соседним точкам"



	Smart blur
	фильтр "Умное размывание"



	Stylize
	группа фильтров "Стилизация"



	Threshold
	команда "Порог" в меню "Изображение > Установка"



	Unsharp Mask
	фильтр "Нечеткая маска", "Нерезкое маскирование", "Снять резкость", "Маскирование нерезкости"



В различных версиях Photoshop русский перевод может отличаться, возможные значения приведены через запятую или в скобках.



Системные требования


• Adobe Photoshop версии 5.0 или выше.
• Процессор не ниже Pentium c технологией MMX.
• Качественный сканер с оптическим разрешением не ниже 600 ppi (относительно качества сканера см. примечание).
• Разрешение монитора не менее 1024х768.
Рекомендуется: процессор с тактовой частотой более 2000 Мгц и кэшем не менее 512 кб, операционная система Windows XP.



Установка, активация и удаление плагина


См. файл ReadFirst.htm в дистрибутиве.



История версий


См. на сайте плагина.



Техническая поддержка и обновление


При возникновении проблем, связанных с инсталляцией или использованием плагина, вы можете обратиться за помощью к разработчику sattva@sattva.ru или посмотреть раздел Разрешение проблем.
Обновление и приобретение: http://www.sattva.ru/descreen.htm
Последняя версия данного описания: http://www.sattva.ru/help/descreen/rus/descreen_manual.htm
Последняя версия плагина: 
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Спасибо, что скачали книгу в бесплатной электронной библиотеке BooksCafe.Net
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